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Pembelajaran Dasar

HTML adalah standarisasi format file untuk transfer informasi via Internet melalui protoco/ HTTP,
Protokol adalah aturan untuk melakukan komunikasi dalam sebuah jaringan, port yang digunakan
untuk HTTP adalah 80 atau 8080.

Format file HTML adalah Plain Text atau text biasa yang dapat diedit dengan word processor
seperti Notepad sekalipun. Ekstensi file HTML ini adalah .html, atau .htm.

Suatu File HTML normalnya memiliki bagian-bagian seperti berikut ini:

<html>
<head>

<title>Judul Website</title>
</head>
<body>

Bagian Yang Tampil di layar
</body>
</html>

Pada Script{isi file atau sebagian teks dalam file htm/} di atas, terdapat tanda-tanda khusus
yang diawali dengan “<” dan diakhiri dengan “>" yang biasa disebut TAG. Tag-tag ini lah yang
mengatur segala hal dalam HTML ini, baik itu mengatur paragraf, warna teks, menampilkan gambar,
dan sebagainya.

|.A. Contoh Sederhana

Silahkan buat file dengan nama latihan.html dengan TextEditor{Applikasi untuk mengedit
Plain Text, con: UltraEdit, Notepad}, kemudian tuliskan script di bawah ini:

<html>
<head> -2 HTML Pertamaku! - Microsoft In... E@@
<title>HTML Pertamaku!</title> Fle Edt Yiew Favortes Tooks Hep *
<éhzad> € >) Lﬂ E]_h
<bo y> »
Address \Documents and Sel % | =4 Go Links
Saya telah dapat membuat<br> Eeip tsend 01| (€
<b>HTML</b> yang paling Sederhana Saya telah dapat membuat
</b0dy> HTML yang paling Sedethana
</html>
Sekarang kita jelaskan fungsi Tag-tag tersebut satu-persatu. & T
# [y Computer

Mulai dari <html> yang maksudnya menyatakan bahwa file
tersebut adalah HTML, <head> yang maksudnya keterangan untuk file HTML tersebut harus
disimpan diantara tag tersebut. <title>HTML Pertamaku!</title> yang maksudnya menentukan
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Judul file HTML tersebut adalah HTML Pertamaku. </head> adalah akhir dari keterangan file
tersebut.

Untuk Bagian di dalam tag <body>...</body> inilah yang akan ditampilkan pada layar
browser nantinya. Jadi script:

Saya telah dapat membuat<br>
<b>HTML</b> yang paling Sederhana

Adalah bagian yang akan tampil di layar. Terdapat tag <br> yang artinya ganti baris. HTML tidak
mengenal karakter Enter, maka untuk mengganti baris digunakan tag tersebut. Sedangkan tag
<b></b> artinya tebalkan tulisan yang berada di dalamnya, yaitu "HTML".

[.B. Mengatur Paragraf

Kita dapat mengatur paragraf atau bagian teks agar lebih teratur, misalnya rata kiri, kanan atau
tengah dengan menggunakan tag: <p align="left|right|center”>T7eks yang akan
diatur< [p>.

Sebelumnya kita akan membahas tentang cara pembacaan Sintak{Cara Penulisan Tag}. Kita
ambil contoh sintak tag di atas, yang artinya <p = nama tag, align="..."” = Atribut untuk mengatur
suatu tag, “left | right| center” = Atribut dapat diisi oleh salah satu isi tersebut, yaitu left, right atau
center. Coba buat file HTML dengan isi body sebagai berikut:

<p align="center”>Tulisan ini akan berada di tengah</p>
<p align="left”>Tulisan ini akan berada di sebelah kiri</p>
<p align="right”>Tulisan ini akan berada di sebelah kanan</p>

I.C. Heading Text

Bila akan memberikan Heading{Judul suatu teks} kita dapat |&@** ® @G L
menggunakan tag-tag heading, yang dimulai dari <hl></h1>, [ &]eivocumentsand settngsioima v | G &0 Ll
<h2></h2>, <h3></h3>, <h4></h4>, <h5></h5>, Ini Headine 1
<h6></h6>. Semakin besar nomor heading, maka semakin kecil | teading
besar tulisannya. Silahkan untuk mencoba Script berikut ini: Tni Heading 2
<hl1>Ini Heading 1</hl>
<h2>Ini Heading 2</h2> Ini Heading 3
<h3>Ini Heading 3</h3> i Heading 4
<h4>Ini Heading 4</h4>
<h5>Ini Heading 5</h5> Ini Heading 5
<h6>Ini Heading 6</h6> b Heating 6

Bl e - T
I.D. Tag-Tag Teks

e <br> Ganti Baris e <i></i> Memiringkan tulisan yang

e <hr> Garis Horizontal ada di dalamnya

e <b></b> Menebalkan tulisan yang e <u></u> Menggaris bawahi tulisan

ada di dalamnya yang ada di dalamnya.

Bila ingin ganti baris

Tidak bisa dengan enter saja, gunakan BR<br>terlebih dahulu<br>
<b>Ini Tulisan Tebal</b>, tuliskan HR<hr>

Untuk menambah garis horizontal, <u>Garis Bawah</b><br>

dan <i>Miring</i>, bisa juga dengan kombinasi

<b><i>Tebal dan Miring</i> juga<br><u>Tebal dan Garis Bawah</u></b>

Bila Script tersebut dijalankan Bila ingin ganti baris Tidak bisa dengan enter saja, gunakan BRE

tetlebih dabalu
pada browser, maka akan T Tulisan Tehal, tuliskan HE

Untuk menambah garis horizontal, Garis Bawah
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mendapatkan hasil seperti berikut ini:

|.E. Format Huruf

Untuk menampilkan tulisan yang menarik, maka kita dapat memformat jenis huruf dengan tag:
<font face="arial|tahoma]...” size="1]|..|7" color="red|green|black]|...”">isi tulisan
yang akan diformat< [font>. Coba Contoh berikut:

<font face="arial” size="5" color="red”>Ini Berwarna Merah</font><br>
<font face="tahoma” size="2" color="blue”>Ini Tahoma Biru</font><br>

Tampilannya akan didapatkan seperti berikut:
Ini Berwarna Merah

Ini Tahoma Biru

I.F. List

Ketika kita ingin menampilkan Listing sesuatu, maka tag <ol start="n"></ol> atau <ul
type=" circle|square|disc”"></ul> dapat digunakan. Perbedaan kedua tag tersebut adalah:
<ol> memiliki Indeks, sedangkan <ul> tidak.

Mutlak untuk menambahkan tag <li>Isi Pilihan< [1i> untuk menampilkan tulisan. Tag ini dapat
digunakan untuk List Berhirarki/bertingkat, silahkan coba script berikut ini:

Ce 1. IndPilihanl
<ol> 2. IniPilihan 2
<1i>Ini Pilihan 1</1i>
<1i>Ini Pilihan 2</1i> Listing wang dimulai dai nomor 9
</ol> Listing yang dimulai dari nomor 9
<ol start="9"> L
<1i>Ini Pilihan 9</1i> 9. IniPilihan 3
<1i>Ini Pilihan 10</1i> 10.  IniFPilihan 10
</ol>
<ul> + [niPilihan 1
<li>Ini Pilihan 1</1i> + L Pilthan 2
<1i>Ini Pilihan 2</1i>
</ul> Listing dengan simbol lingkaran Listing dengan sitmbol lingkaran
<ul type="circle”>
<l%>In% P%l%han ling]liaran</li> = Iri Pilihan lingkaran
<1i>Ini Pilihan 2</1i> - IniPilihan 2
</ul> Listing Bertingkat
<ol> o )
<li>Indonesia</1i> Listing Bertinigkat
<ul><li>Jakarta</1li>
<li>Bandung</li></ul> 1. Indonesia
<li>Amerika</1li> = Jakarta
<ul><li>New York</li> = Bandung
<li>Washington</li></ul> 2. Amerika
</ol> o Mew Vork
< Washington

I.G.Teks Tanpa Format / Preformated Text

Kadang kala kita menginginkan suatu teks ditampilkan apa adanya di layar, tanpa memberikan
tag <br> untuk berganti baris, dan agar teks tersebut berderet dengan sejajar antara satu huruf
dengan huruf lainnya.

Hal tersebut dapat ditanggulangi dengan tag <pre></pre>, untuk lebih jelasnya silahkan coba
contoh berikut ini:

<pre>
Ini adalah contoh penggunaan tag pre

Kita tak perlu memakai br untuk ganti baris
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tinggal menekan tombol enter

Tag ini juga dapat dipakai untuk isian

Nama : Ahmad Amarullah
Jurusan : Manajemen Informatika
Fakultas : Teknik

</pre>

Coba bedakan hasilnya dengan tanpa mengikut sertakan tag <pre></pre>.

[.2. Blockquote

Bila suatu teks ingin dijorokkan ke sebelah kanan, HTML menyediakan Tag blockquote untuk
melakukannya.

Ini tulisan yang tidak menjorok ke kanan, Ini tulisan yang tidak menjorok
ke kanan,
Ini tulisan yang tidak menjorok ke kanan,

<blockqgquote>
Ini tulisan yang menggunakan blockquote dan
menjorok ke sebelah kanan Ini tulisan yang

Tni tulisan yang tidal menjorok ke kanan, Ini tulisan yang
tidak menjorol ke kanan, Ini tulisan vang tidak menjorelk

ke kanan,
menggunakan blockquote dan menjorok ke sebelah
kanan Tni tulisan yang menggunakan blockquote dan
</blockgquote> tnetyerok ke sebelah kanan I tulisan vang
Tulisan ini kembali tidak menjorok ke sebelah menggunakan blockouete dan menjorok ke
kanan sebelah kanan

Tulisan ind kembali tidak menjorok ke sebelah kanan

l. Tabel dalam HTML

Selain Format Huruf, Hyperlink dan sebagainya, dalam xHTML juga dapat menyisipkan tabel.
Tabel tidak hanya berguna untuk menampilkan Tabel Data, tapi juga untuk membuat kolom-kolom
atau baris-baris seperti pada surat kabar.

Standar Penulisan Tabel:
<table border="1">
<tr>

<td>Kolom Pertama Baris Pertama</td>
<td>Kolom Kedua Baris Pertama</td>
</tr>
<tr>
<td>Kolom Pertama Baris Kedua</td>
<td>Kolom Kedua Baris Kedua</td>
</tr>
</table>

Tag <table> digunakan untuk mendefinisikan bahwa bagian tersebut adalah sebuah tabel,
<tr> mendefinisikan baris, <td> mendefinisikan kolom. Pada tag <tabel> dapat diisikan atribut
border="besar border”, width | cellspacing | cellpadding | background | bgcolor.

Sedangkan pada tag <td> dapat ditambah atribut colspan|rowspan |valign|align|
background | bgcolor | width.

Coba Contoh berikut ini:

<table border="1" cellpadding="4" cellspacing="1">

<tr>
<td bgcolor="gray">No</td>
<td bgcolor="gray">Nama</td>
</tr><tr>

<td>1</td>
<td>Ahmad Amarullah</td>
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</tr><tr>

<td>2</td>

<td>Wahid Ahmad</td>
</tr><tr>

<td>3</td>

<td>Toyib Wahyudin</td>
</tr>
</table>

I\\

Contoh Membuat Tabel dengan Merger-cell “collspan/rowspan”:

<table border="1" cellpadding="2" cellspacing="2">
<tr>
<td bgcolor="#ffefdd" colspan="2">Colspan 2</td>
<td bgcolor="#ffefdd" colspan="3">Colspan 3</td>
<td bgcolor="#ffefdd" rowspan="2">Rowspan 2</td>
</tr><tr>
<td bgcolor="#efffdd">Tanggal</td>
<td bgcolor="#efffdd">Bulan</td>
<td bgcolor="#ddefff">Modal</td>
<td bgcolor="#ddefff">Penjualan</td>
<td bgcolor="#ddefff">Laba/Rugi</td>
</tr><tr>
<td>2</td>
<td>Januari</td>
<td>7000</td>
<td>7500</td>
<td>500</td>
<td>Untung</td>
</tr><tr>
<td>4</td>
<td>Januari</td>
<td>8000</td>
<td>6500</td>
<td>1500</td>
<td>Rugi</td>
</tr>
</table>

T

Fowspan 2
1 | Ahmad Amarallah Tanggal |Bulan | Modal Penjualan LabaFBugi
7 | Wahid Ahmad 2 Tatmari (7000|7500 500 Untung
4 Tatmari (2000 (6500 1500 Fugi

3 | Toyih Wahyudin
Tampilan Contoh 1 Tampilan Contoh 2

Contoh Tabel dengan valign:

<table border="4" cellpadding="2" cellspacing="6">
<tr>
<td>Kolom 1</td>
<td>Kolom 2</td>
<td rowspan="2" valign="top">Valign Top</td>
</tr><tr>
<td rowspan="2" valign="bottom">Valign Bottom</td>
<td>Kolom 2 Baris 2</td>
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</tr><tr>

</tr>

<td>Kolom 2 baris 3</td>
<td>Kolom 3 Baris 3</td>

</table>

Contoh Tabel untuk kolom berita:

<table cellpadding="3" cellspacing="3">

<tr>
<td valign="top" width="50%">
<hl>Berita Utama</hl>
<h4>KPU Menyetujui Saran Presiden</h4>
Jakarta, kpu.go.id-Komisi Pemilihan Umum (KPU) beryakinan
logistik Pemilu akan sampai ke daerah-daerah pada waktunya.
Beberapa langkah efisiensi juga dilakukan oleh lembaga ini
untuk menghemat dan mempercepat distribusi logistik ke TPS-TPS.
<h4>Daftar Caleg DPR RI dari PDIP Kaltim Sudah Sah</h4>
Jakarta, kpu.go.id- Komisi Pemilihan Umum (KPU) akhirnya
mensahkan caleg DPR RI dari PDIP Kaltim yang beberapa waktu
lalu menjadi kontroversi serius di Kaltim.
</td>
<td valign="top" width="50%">
<hl>Berita Kampus</hl>
<h4>Konfrensi Seminar Microsoft</h4>
Pada hari rabu ini, para dosen dan ofisial Universitas
Komputer Indonesia melakukan seminar akademik teknologi
dengan Microsoft di gedung miracle Unikom...
<h4>Pembayaran Angsuran</h4>
Pembayaran angsuran akan dilakukan secara Auto Debet
dari rekening masing-masing mahasiswa.
</td>
</tr>
</table>
[Kolom 1 [Kolom 2 Valian Top Berita Utama Berita Kampus
|K°1°m 2 Baris 2 EPU Menyetujui Saran Presiden Konfrensi Seminar Microsoft
Valign Bottern |K010m 2 baris 3 |K010m 3 Banis 3 Takarta, kpu.go.id-K omisi Pemiihan Urmum  Pada hari rabu ini, para dosen dan ofisial
(EPU) beryakunan logistik Permilu akan sampan  Universitas K omputer Indonesia melakukan
Tampl Ian Contoh Va“gn ke daerah-daerah pada waktunya. Beberapa  seminar akadernik teknologl dengan Microsoft

langkah efistensi uga dilabukan oleh lembaga i gedung miracle Unikom..
ini untuk menghemat dan mempercepat
distribusi logistik ke TP5-TPS Pembayaran Angsuran

Daftar Caleg DPR RI dari PDIP Kaltim  Pembayaran angsuran akan dilakukan secara

Sudah Sah Auto Debet dan rekening masing-masing
mahasiswa.

Takarta, kpu.go.id- Komisi Pemilihan Umum

(K PU) akhirnya mensahlkan caleg DPE RI dari

PDIP Ealtitn vang beberapa walctu lalu

menjadi kontroversi serus & Kaltim

Tampilan Contoh Berita

Perbedaan Cellpadding dan Cellspacing
Cellpadding dan Cellspacing sama-sama merupakan jarak kolom atau baris, tetapi posisi
penjarakan tersebut berbeda, untuk cellspacing menjaraki antara sebuah kolom dengan kolom lain
dari luar, sedangkan untuk cellpadding menjaraki antara sebuah kolom dengan teks yang berada di
dalam kolom tersebut. Untuk lebih jelasnya lihat gambar berikut:
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TABEL

EKS 1] 2]
tieks teks teks teks leks leks
|teks teks teks teks leks Leks
teks teks teks teks 1eks leks
|teks teks leks teks eks Leks
teks teks teks teks 1eks leks
|teks teks teks teks leks Leks
teks teks teks teks Leks Lleks
|teks teks teks leks Leks Lleks
Leks teks teks teks leks leks

|__|.Laks.lekueks____ T

- cellpadding cellspacing

lI.  Menyisipkan Gambar

Suatu website akan sangat hambar bila yang disajikan hanya berupa tulisan, dan warna-warna
saja. Tapi dengan adanya suatu gambar maka website itu akan terasa meriah, dan enak dilihat.
Selain itu gambar merupakan alat komunikasi yang universal dan mudah dimengerti, hanya dengan
melihat gambar tersebut dengan sekejap, maka kita akan langsung mengerti apa maksudnya.

Kita dapat melakukannya dengan menggunakan tag: <img src="alamat:gambar”>

Menampilkan gambar di direktori yag sama

<img src="monitor.png" width="128" height="128" alt="Monitor”><br>
Menampilkan Gambar di direktori lain

<img src="gambar/unikom.jpg" width="188" height="188" alt="Unikom"><br>
Menampilkan Gambar di sebelah kanan

<img src="uc.gif" width="140" height="44" alt="Unikom Center"
align="right">

a El!

»

Atribut- Atribut Khusus: File Edt Wiew Favortes Tools Help

e SIC o esack - Q @ @ f@ pSearch *Favorites @ 8' ; - L‘J @
Untuk menentukan lokasi file
gambar, bisa berupa Absolute
URL ataupun Relative URL.

e width
Menentukan panjang gambar
berdasarkan pixel

¢ height
Menentukan tinggi gambar
berdasarkan pixel

o alt
Memberikan Alternatif Text
bila image tidak ada. Di
beberapa browser, atribut ini

Address ] http: /localhostjwebother/xhtrfiatihan. html BB ks >

Menampilkan Gambar di direktort lain

dijadikan sebagai tooltips Menampillcan Gambar di sebelah kanan

e align J unikom
Menentukan letak “gcenter
penempatan gambar @Done QLOC6| intranet

e border
Menentukan bersar bingkai gambar berdasarkan pixel, bila di set 0, maka bingkai tidak akan
ada.

<img src="http://www.yahoo.com/gambar/1.png" width="153" height="60"
alt="Tidak Ada">

Dengan Atribut <b>alt</b> bila ternyata gambar yang dimaksud tidak ada,
maka gambar

tersebut akan diganti dengan tulisan alt tersebut.
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hiipsifincalhosifve botherxhimiYiaihan3shimiE=m duﬂ

File Edit \Miew Fawvarites Tools  Help #

Kita bisa menampilkan gambar dari
server lain di internet, dengan
src="alamat” menggunakan protokol Back = o Favorites
http://www.alamat.com/gambar.gif, @ @ @ @ @ ’O *

tetapi bila tidak ada, maka yang tampil | Address | @] hetp:fflocalhostwebetherj<htmiflatihan3 heml Blc ks »
hanya berupa teks alt. A

»

B

[x] Tidak Ada

Dengan Atribut alt bila ternyvata
gambar yang dimaksud tidak ada, maka gambar tersebut alan
diganti dengan tulizan alt tersebut.

@ Done I I (R | Q Local intranet
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V. Hyperlink

Apa itu Hyperlink?

Hyperlink adalah suatu kelebihan dari HTML, dimana file HTML yang sedang diakses dapat
dengan mudah berpindah pada link lainnya hanya dengan mengklik hyperlink tersebut.

Hyperlink terbagi kedalam 3 Jenis, yaitu Absolute URL Hyperlink, Relative URL Hyperlink, dan
Hyperlink dengan Anchor (Hyperlink dalam file yang sama). Untuk menampilkan hyperlink cukup
dengan menuliskan tag seperti <a href="link_tujuan”> Teks HyperlLink<[a>.

Absolute URL Hyperlink

Jenis-jenis hyperlink tersebut hanya dibedakan berdasarkan kemanakah link tersebut
diarahkan. Pengarahan Hyperlink berada pada Atribut href. Untuk Absolute URL maka lokasi link
tujuan ditulis secara lengkap, termasuk port dan hostnya. Biasanya digunakan untuk melakukan link
ke server lainnya (contoh: href="http://www.unikom.ac.id/"”). Lihat Contoh Hyperlink untuk
lebih jelasnya.

Relative URL Hyperlink

Bila Link tujuan masih berada di dalam server/komputer yang sama, maka kita tidak perlu
menuliskan alamat link secara lengkap, cukup dengan lokasi direktori dan filenya (contoh:
href="/berita/berital.html”). Lihat Contoh Hyperlink untuk lebih jelasnya.

Anchor Hyperlink

Selain berpindah file, kita juga dapat berpindah layar pada file yang sama, misalnya suatu
tulisan berada di bawah, dan di atas merupakan daftar isi, ketika kita melakukan klik pada Hyperlink
tersebut, maka layar akan otomatis menggulung ke tempat yang dimaksud.

Syaratnya harus terdapat Anchor / tag <a></a> yang memiliki atribut name (misalnya <a
name="bagian_bawah"></a>), dan dapat dipanggil dengan cara <a
href="#bagian_bawah"”>Teksnya</a>. (menggunakan karakter pagar “#" diikuti nama Anchor
yang dimaksud.

Lihat Contoh Hyperlink untuk lebih jelasnya.

CONTOH HYPERLINK
Buat dua buah file dalam satu direktori yang sama, dan beri nama latihanl.html dan
latihan2.html. Dan isi file-file tersebut adalah seperti berikut ini:

Latihan1l.html

<html>
<head>
<title>LATIHAN HYPERLINK 1</title>
</head>
<body>
<h2>Latihan Hyperlink 1</h2>
<h3>CONTOH Absolute URL</h3>
Bila dilakukan klik <a href="http://www.yahoo.com">Di Sini, maka halaman
ini akan berpindah ke yahoo!</a><br />
Bila dilakukan klik <a href="http://www.google.com" target=" blank">Di
Sini, maka akan tampil window baru yang mengarah ke google</a><br />
<h3>CONTOH Relative URL</h3>
Untuk Berpindah ke Latihan 2 <a href="latihan2.html">Klik Disini</a>
</body>
</html>

Latihan2.html

<html>
<head>
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<title>LATIHAN HYPERLINK 2</title>
</head>
<body>
<h2>Latihan Hyperlink 2</h2>
<a href="latihanl.html">K1lik disini untuk kembali ke Latihan 1</a><br />
Dalam Latihan 2 ini, kita akan mencoba Link dengan Anchor:<br /><br />
<ul>
<li><a href="#bagianl">Tentang Saya</a></1li>
<li><a href="#bagian2">Hobbi saya</a></1li>
</ul>
Berikan Atribut <b>name</b> untuk Anchor
<a name="bagianl"></a>
<h2>Tentang Saya</h2>
Saya adalah saya.<br />Saya adalah saya.<br />
Saya adalah saya.<br />Saya adalah saya.<br />
Saya adalah saya.<br />Saya adalah saya.<br /><br />
<a name="bagian2"></a>
<h2>Hobbi Saya</h2>
Saya Suka xHTML<br />Saya Suka xHTML<br />
Saya Suka xHTML<br />Saya Suka xHTML<br />
Saya Suka xHTML<br />Saya Suka xHTML<br /><br />

</body>
</html>

Setelah menyelesaikan kedua file tersebut, e ,
silahkan  untuk membuka file latihanl.html [Z e v roows oo e 3
menggunakan Browserl maka akan tampll Sepertl Agdl’ess|ahttp:p'flu(alhustfwehnthﬁrixhtm\ﬂatlhan1.htm\ B ks >
berikut ini, lalu coba satu-persatu link yang ada: Latihan Hyperlink 1

Tampilan seperti berikut ini:
Kemudian coba untuk mengklik link pertama,
maka Alamat URL akan berpindah ke Yahoo!, Karena | oo i i b s ms e e el ke el
menggunakan Absolute URL. CONTOH Relative URL
Bila link yang kedua di klik, maka akan tampil
window baru dengan Alamat URL yang mengarah ke

CONTOH Absolute URL

Untuk Berpindah ke Latihan 2 Elik Disini

Google, karena menggunakan Atribut & ol e
target="_blank". T
Dan B|Ia k|ta melakukan k“k pada L|nk ke -"@drESS|?ahttp:,l’,l’www.yahoo.com;l

Tiga, maka Alamat URL akan berubah ke file
latihan2.html, dan halaman web pun akan berubah
menjadi halaman latihan2.html.

Pada Gambar di Atas, terdapat 2 Hyperlink yang
mengarah ke Anchor (ke bagian tertentu di file tersebut). | Vthan Hyperlink2
Bila dilakukan klik pada “Tentang Saya”, maka Halaman [ S btk e o e sschor
akan bergeser menjadi seperti berikut: - Tenang Son

Tapi bila yang di klik adalah “Hobbi Saya”, maka | *™**
Halaman akan bergeser menjadi seperti berikut: e

LATIRIAR RN ERCL S

Fie Edi Vew Favores

ols  He -
Address | @] hitp:/flacalhastjwebother| shimllathan2 bt Be ks

7]

Tentano Sava ]
&) Dore. & Local intranet

Atribut-Atribut Khusus:

e href LR AN I oo
. . . ) Fle Edt Wiew Favorites Tools Help a
Lokasi Link Tujuan, bisa berupa Absolute URL, |ssre: @ i g8« w:>
. . Hobbi Saya [
Relative URL, atau Anchor Link.
Saya Suka ZHTML
Saya Suka zHTML
o target Saya Suka sHTML
Saya Suka xHTML
. . . Saya Suka ZHTML
[W3C pada standarisasi xHTML tidak menyarankan | ssssiasnd =
€ 83 Local intranet 7

untuk menggunakan atribut ini. ]
Target Window atau Frame yang dituju, berupa:

o _blank : Target ke Window Baru
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| 1 ]

o _self : Target ke Frame dan Window yang sama.

o _parent : Target ke Frame yang lebih atas satu tingkat dalam Window yang sama.

o _top : Target ke frame paling atas dalam Window yang sama.

o Dapat juga berupa nama frame. Lihat Pembahasan tentang Frame & Frameset,

(] name

Memberikan nama untuk menjadi Anchor.

V. FRAME

Selain hanya dapat menampilkan satu file dalam satu

A Penggunaan Frameset - Microsoft Internet Explorer [9]=1]E]
Wiew ,F'l

Adldress | ] http: flocalhostfwebother xhtmllatihan2/fremeset. himl

Tools  Help

v| B e ks *

halaman, kita juga dapat menampilkan beberapa file
dalam satu tampilan, yaitu dengan frame dan frameset.
Lihat pada contoh berikut.

o,

IEM Express: Terjangkan,
Mudah, Cepat untuk KM
IEM membidik pangsa pasar
usaha keeil menengah (UKM)
dengan metneurkan scbuak

Serangan Mydoom

Waspadai munculya serangan
worm e-mail Mydoom
(W32Mydoorm) vang ditengarai

I

<html>

protofolio penawaran dan program khusus yang
bertajuk IEM Express

<head><title>Penggunaan O

menyebar dengan cepat.

Software Pilihan

et W

Frameset</title></head>
<frameset rows="*,*">

Website Berita

<frame name="atas" src="image.html" /> TIE HARTTN Cuaca Hai b

<frame name="bawah" src="tabel.html" /> Tt s el ks Wi Row o B
</frameset> g mengeptimalian pessesas LT P Bmomg  20°C  Beavm
< / html> 4:;1 Done &3 Local ntranst =

Kita dapat merubah bentuk frame tersebut, dengan merubah atribut rows dengan cols, dan

tag <frame />. Lihat Contoh-contoh berikut.

Secara Horizontal
<frameset cols="*,*">

A Penggunaan Frameset - Microsoft Internet Explorer EEX
:,l

Bls Edt Wew Favortes Inols Help

address ] hitps htrnl D=
—"1 3 s . " ~ ~
<frame name "klrl "src image.html "/> s s | Website Berita
<frame name="kanan" src="tabel.html" /> i-EI‘ B
erjangkan,
</frameset> == |Mudah, s | TIPHART  CnacaHarilni
/ -— Cepat n | INI
ke URM I\
TEM sembidic pangsapasar gll'ﬁl“ﬂﬂi .
usaha kecil menengah (UK M) resentasi
dengan mebwmcwrkan scbuah  § | Web untuk 1;3@ gan;"“g
protofolio penawaran dan Browser ore ancing
program khusus yang bertajk. 01 | Tertentu Siang  Jdkarta
IBM Espress o
Piv | mengoptimalkan ~
< > < >
&] Done: &J Local intranet.
Horizontal dan Vertical :
Fie Edt ‘iew Favorites Tooks Help -
<frameset rows="60,*"> 2iress [ oo VB
_n " _n n -
<frame name atas P LC form.html / > Folmulir Pendaftaran E-Mail Mahasiswa =
<frameset cols="*,*"> < >
—ni s —_nz " ) 2 - . . 2
<frame name="kiri" src="image.html" /> mC s Website Berita
<frame name="kanan" src="tabel.html" /> ill4> Tevecan,
% |Mudah s | TIPHARI Cuaca Harili
</frameset> = lega | M@
ke TR M I\
</frameset> ik pmgrapere Opinas | ikt
aha keecil ah (VR resentasi
rmgen memeson s § | Web wntuls za@ pandug
P B ¥/ Demrrcmne ore Bandung ¥
< > < >
&] pone & Local intranet.
Menu di sebelah Kanan, Header di Atas dan Footer 2 Penggunaan Frameset - Microsoft Internet Explorer EEX
di b h Ele Edt View Favortes Tooks Help "
1 awa address | @] htal v B ks *
<frameset rows="60,*,70"> ] ]
" " . " " . Latihan Hyperlink 1
<frame name="atas" scrolling="no" noresize
src="../latihanl.html"™ /> = Website Berit 2
Vebsite Berita
<frameset cols="150,*"> i-&) ‘
<frame name="kiri" src="image.html" /> == gﬁﬂﬂu Cuaca Hari Ini
<frame name="kanan" src="tabel.html" /> —— Derticane ¥
</frameset> Folmulir Pendafi E-Mail Mal =
olmulir Pendaftaran E-Mail Mahasiswa
<frame name="bawah" src="form.html" /> . B
< / frameset> &) bore % Local intranet
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VI. Membangun Website
dengan Dreamweaver

Buka applikasi Macromedia
Dreamweaver untuk memulai pembangunan
website  dengan  Dreamweaver.  Setelah
dijalankan, maka akan tampil jendela seperti
gambar di sebelah kanan ini:

A. Membuat Halaman Baru

Untuk membuat halaman baru dari jendela
utama tersebut adalah dengan memilih menu
File > New, lalu pilih Category Basic Page
dan HTML. Kemudian tekan tombol Create,

maka akan tampil halaman kosong yang siap untuk kita isi dengan apa saja yang kita inginkan. Untuk
melakukan edit teks, dapat dilakukan dengan mudah seperti pada word processor lainnya, mis:

Microsoft Word.
Select Image Source
Select file name fiom: (3 File system
O Data sources
Look jn: | (=) Sample Pictures ¥ & & £° @ Image previot

Blue hills.ipg

Water llies.jpg

v
File hame: \mm g \ | 0K ] 800 % 600 JPEG, 70K /10
J

Files of type: | Image Files ["gi" pw"peg:"png) v [caneal

URL [fle: /€D ocuments and Settings/Al Users/Do|

Fielative to: Untifed-2

Diocument should be saved to use this option. Preview images

C. Membuat Link

Untuk memasukan Link dapat dilakukan dengan memilih
menu Insert > Hyperlink, maka jendela Hyperlink |
seperti pada gambar di samping kanan akan tampil. Tile: | |
Masukan parameter-parameter ada pada jendela ini, lalu | acessker:[ |

tekan OK.
Parameter:

B. Menyisipkan Gambar kedalam
Halaman Web

Untuk memasukan gambar dapat dilakukan
dengan memilih menu Insert > Image, maka
jendela untuk memilih gambar-pun akan tampil
seperti gambar di samping kiri.

Pilih gambar yang akan dimasukan, lalu klik OK,
maka gambar pun akan tampil di halaman website
yang sedang diedit.

Text: | |
| 3 ©

Tab inde:x: I:l

e Text : Tulisan yang akan tampil pada hyperlink
e Link : File HTML atau Lainnya yang akan dihubungkan dengan link tersebut
e Target : Target Link tersebut akan ditampilkan dimana,

apakah _blank _parent, dll.

o Title : Tooltip yang akan tampil ketika link tersebut di | ™"

hover oleh cursor mouse.

D. Membuat Tabel

Untuk membuat tabel dapat dilakukan dengan memilih menu | e
Insert > Table, maka jendela Table akan tampil seperti gambar
di sebelah kanan. Atur Rows (Jumilah Baris) dan Colomns
(Jumlah Kolom) untuk tabel yang akan dibuat, lalu klik OK untuk | acessbir,

membuatnya. Coption: |
Align caption:
E. Menyimpan Halaman
Untuk menyimpan halaman website yang telah dibuat dapat
dilakukan dengan memilih menu File > Save. Bila pertamakali

Table 3

Rows: Columns:
Table width:
Border thickness: pixels
iZell padding: l:l
Cell spacing: l:l

annm
a0
i

Top Both
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menyimpan, maka kita diharuskan memberi nama file tersebut, dan menyimpannya pada direktori
tertentu. Selalu diingat dalam penamaan file sebaiknya tidak menggunakan spasi dan sependek
mungkin, juga selalu gunakan huruf kecil, seperti biodata.html atau hobby.html. Tidak disarankan
memberi nama: Biodata Saya.HTML, HOBBY.html.

Dan selalu diingat untuk membuat file index.html sebagai file awal atau home.

Latihan: Buatlah dengan Dreameweaver sebuah halaman website tentang SMU Online Bandung,
dengan menu Profile Sekolah, Visi dan Misi, Sejarah, dan Berita, dan Link ke website Google,
Yahoo, dan Unikom. Sisipkan gambar-gambar pada setiap halaman websitenya, dan atur kolom-
kolom dengan menggunakan tabel, pakai Huruf seperti Arial dan Tahoma untuk Teksnya. Lihat
contoh di bawah ini:

edia Dreamweaver MX 2004 - [Untitled Document (web/findex.html)]

Flle Edit “iew Insert Modify Text Commands Site  Window Help

Common ¥ QE’&‘@@'@'@"Q i b Design
i Code
- -
indes:. html _ & x || ¥ Application
‘l._;ICD\:Ie |j5pht |ﬁ| Design ‘ Titles |Untitled Document lﬁ\‘:‘f it & | ' g ::q Inspector _
. i ¥ Files =
Files

Manage Sites
E[& Desktop

:') My Computer

‘3 My Network Places

~BH FTP&.RDS Servers
B Desktop items

Website Informasi dan Komunitas SMU Bandung

Profile Sambutan Kepala Sekolah
Visi dan Misi

Se]'?"a|1 Sambutan Kepala Sekolah ditulis di sim Sambutan Eepala E
Berita Sekolah dituliz & sini Sambutan Eepala Sekolah ditulis & smi
Sambutan Kepala Sekolah ditulis di sim Sambutan Eepala E
Selolah dituliz di sini Sambutan Kepala Sekolah ditvlis di sini
Sambutan Eepala Sekolah ditulis di sim Sambutan Kepala Sekolah ditulis i sm 3
Sambutan Kepala Sckolah ditulis di sini Sambutan Kepala Sckolah ditulis di sn 3
Sambutan Eepala Sekolah ditulis di sitd. :

Sambutan Eepala Sekolah dituliz di sitd Sambutan Eepala Sekeolah dituliz i s
Sambutan Kepala Sekolah dituliz & sinl Sambutan Kepala Sekolah dituliz & sind ;
Sambutan Eepala Sekolah ditulis di sim Sambutan Kepala Sekolah ditulis di s
Sambutan Eepala Sekolah ditulis di sim Sambutan Kepala Sekolah ditulis i i
Sambutan Eepala Sekolah ditulis di sim Sambutan Fepala Sekolah ditulis di si
Sarmbutan Kepala Sekolah dinlis di s].ml

! Hak Cipta (<) 2005 Oleh SMU Online Bandung
Dipatiukur 112-113 Bandung
23% [(196) = 5496 [479) * 23% (197) =
100% (308) ~ {

<body> <table> <tr> <td> <p> 930 x 540 » 104K [ 15 sec
i ¥ Properties =
Format [Paragraph | Style | Hone vl Bz = v|oo %
Fontl Default Fonk vl S|za| None vl E =
T o et v o oD S . s
£ 3F et H | Header[] 83 [ ] | rar [ | .
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